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Abstract

All cells in the human organism, including stem cells, have a limited lifespan and cease to divide after a certain number of divisions. The process of cellular senescence
refers to incapability to progress through the cell cycle, thus leading the cell to an irreversible growth arrest. One of the most common biomarkers of cell senescence
is senescence-associated [3-galactosidase (SA-B-Gal/SABG), a lysosomal enzyme detectable at pH = 6.0. However, the proper identification of senescent cells is still
insufficient and lacks adequate quantification parameters. In this paper we showed that fractal and gray level co-occurrence matrix (GLCM) texture analysis of cell
nuclei are able to discriminate senescent from non-senescent cells. A total of 105 images of DTSCs nuclei from both SA-B-Gal+ and SA-B-Gal- cells were used
in this study. All of the computed parameters (fractal dimension, angular second moment, inverse difference moment, contrast, entropy and correlation) showed
significant statistical difference between the nuclei of senescent and non-senescent stem cells (p < 0.001). Our results show the possible practical value of fractal and

GLCM texture analysis as the new markers in the determination and quantification of DT'SCs senescence.

Introduction

Dental pulp stem cells (DPSCs) represent a heterogeneous
population of multipotent stem cells that have the ability to differentiate
into various types of cells [1]. Since they can be easily obtained from
teeth during routine dental procedures, especially DPSCs from human
deciduous teeth (also known as deciduous teeth stem cells, DTSCs),
have gained a very large attention in recent years from a potential
therapeutic standpoint [2].

All cells, including stem cells, have a limited lifespan. After a
certain number of divisions, stem cells are subjected to aging, which is
characterized by different morphofunctional parameters. One of those
changes is the accumulation of lysosomal enzyme {-galactosidase at
pH = 6.0 (senescence-associated P-galactosidase/SA-B-Gal/SABG),
whose activity is associated with cell senescence in vitro [3,4]. The
process of cellular senescence refers to irreversible growth arrest,
which is followed by changes in nuclear factors [5]. Although SA-B-Gal
is widely used as a biomarker for detecting aging and senescence in
stem cells in vitro [6], the proper identification of senescent cells is still
insufficient and cell-based methods for identification of those cells are
not quantitative [7].

Fractal analysis is a method used to measure the complexity of
an object. It is widely used in several different areas of biological and
medical sciences, such as neuroscience [8-11], histological diagnosis
and quantification of neoplasms [12-15], blood vessels changes [16,17],
assessment of cell aging [18] and many others. New methods and
modifications of fractal analysis are also being discovered [19], thus
allowing this mathematical method to be applied in different areas
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of natural sciences. Unlike fractal analysis, gray level co-occurrence
matrix (GLCM) texture analysis can be used in biomedical research
to analyze texture features of histological images and also to quantify
structural changes in cells and tissues [20,21].

Based on this background, our idea was to determine whether
fractal and GLCM texture analysis of DTSCs nuclei could prove as a
useful tool in the detection and quantification of stem cell senescence
in vitro.

Materials and methods

Deciduous teeth stem cells isolation

Deciduous teeth stem cells were isolated from a healthy deciduous
maxillary central incisor obtained from a 7 year old child. The tooth
extraction was done with informed consent of its parents and ethical
comity approval. Pulp tissue was minced into 1-2 mm fragments,
transferred to 35 mm Petri dishes and cultivated using Dulbecco’s
modified Eagle’s medium (DMEM) / Ham’s F12 (1:1, Invitrogen,
Carlsbad, California, USA) supplemented with 10% FBS MSC
qualified (Invitrogen, Carlsbad, California, USA) and AA solution,
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and incubated at standard conditions (37°C, 5% CO,). The DTSCs
used for this experiment were from passage number four. Additional
experimental information about dental pulp and stem cell isolation can
be found in Martacic¢ et al. [22].

Senescence-associated p-galactosidase activity

Senescence-associated P-galactosidase activity was determined
by using a commercial kit (Senescence Cells Histochemical Staining
Kit - Sigma-Aldrich) according to the manufacturer’s instructions.
Approximately around 2.5 x 10* DTSCs were cultured in each well
(Multiwell Glass Chamber Slides, BD Biosciences) during 24 hours,
after which they were washed in PBS, fixed with a 4% formaldehyde for
5 minutes at room temperature and then incubated at 37°C overnight
in a freshly prepared staining solution containing X-Gal (5-Bromo-4-
chloro-3-indolyl -D-galactoside) at pH = 6.0. After washing in PBS,
the cells were counterstained with Mayer’s hematoxylin for better
visualization of nuclei. The SA-B-Gal positive (SA-p-Gal*) and negative
(SA-B-Gal’) cells are shown in Figure 1.

Figure 1. SA-B-Gal staining in DTSCs. A — Microphotograph of SA-B-Gal'cell with
characteristic greenish-blue accumulations in the cytoplasm (*), indicating cell senescence.
B — An example of SA-B-Galcell, i.e. non-senescent cell (magnification x1000).

Acquisition and graphic processing of images

For fractal and GLCM texture analysis of DTSCs nuclei, digital
photos were taken with an Olympus digital camera (Olympus C5060-
ADU) and analySIS 5.0 software (Soft Imaging System, Olympus) at
x1000 magnification with immersion. The images were saved in TIFF
format with a dimension of 2592 x 1944 pixels, resolution of 200 DPI
and bit depth of 24. All picture elements, except the nucleus itself, were
removed. Also, in order to avoid the influence of rotational variations
on the value of fractal dimension (FD) all nuclei were placed centrally
and rotated so that their longer axis was parallel to x axis (Figures 2A
and 2E). After this graphic processing, a total of 105 images containing
a single nuclei per picture (obtained from 55 SA-B-Gal* and 50 SA-B-
Gal cells), were used for further fractal and GLCM texture analysis.

Theory/calculation
Fractal analysis using the box-counting method

The lower and upper box-dimensions of a subset F < R" are
respectively defined by
; . . log Ny(F
dim, () = lim 8D i () = i 22Dy
s>0 —logo -0 —logo
and if those values are equal then the common value is referred to as the
box-counting dimension of F and is denoted by

dim, () = lim 128 e ()
e J— ]og o)

where N(F) can be the smallest number of closed balls of radius &
that cover F, the smallest number of cubes of side § that cover F, the
number of §-mesh cubes that intersect F, the smallest number of sets of
diameter at most § that cover F or the largest number of disjoint balls
of radius & with centers in F [23]. The box-counting method, applied on
digitized images, covers the image with a grid of square cells (with cell
size r), where for binary images the cell size is expressed as the number
of pixels. The number of squares N(r) needed to cover the image is
given by a power law

N(r)=const-r " (3)

where D, is the box dimension, obtained as an absolute value of the
slope of the log-log relationship between N(r) and r [24].

)

Image processing and fractal analysis were carried out in the
Image] 1.48v software (NIH, Bethesda, USA; free download from
http://rsbweb.nih.gov/ij). We calculated two forms of FD: the FD of
the “binary-outlined” nucleus (D, ), which measures the shape of an
image (Figures 2C and 2G) and the FD of the corresponding “black-

. -
.

Figure 2. Graphic processing of cell nuclei. The first row represents the steps in the graphic processing and analysis of SA-B-Gal” cell nuclei (images A to D), while the second row
represents the same steps applied to the nuclei of SA-B-Gal cells (images E to H). A, E — all of the nuclei were positioned centrally and rotated in the same order to avoid the rotational
variations which can influence the value of fractal dimension. B, F — grayscale nuclei images used for texture analysis. C, G — images of the “binary-outlined” nuclei, on whom the
skeletonization process was applied in order to calculate D_ . The skeletonized images are not shown in this figure, due to the small thickness (1 pixel) of the line. D, H - “black-and-white”

images of the same nuclei used for calculating D,
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and-white” image (D,, ), which evaluates the space-filling property of
an image (Figures 2D and 2H).

In order to calculate D_, firstly the images were converted to
an 8-bit format (pathway: ImageJ>Image>Type>8-bit), followed by
the Find Edges command in order to outline the nucleus (pathway:
ImageJ>Process>Find Edges) and then finally transformed to a
binary format (pathway: Image/>Process>Binary>Make binary) and
skeletonized (pathway: ImageJ>Process>Binary>Skeletonize) (Figure
2). The same procedure was used to calculate D, but with an addition
of the Fil command after the binarization process, which in this case,
represented the last step in the process of image transformation
(Figures 2D and 2H)

The fractal analysis was done using the box-counting method
(pathway: Image]>Analyze>Tools>Fractal Box Count). By default, the
box sizes for counting the fractal dimension using the Image] software
are 2, 3, 4, 6, 8, 12, 16, 32, 64. In this paper, the box sizes were 1, 2, 4,
8, 16, 32, 64, 128, 256, 512, 1024, obtained as an increasing geometric
progression 2" where n = 0, 1, 2...10, as also used in our previous
papers [9,19].

Gray level co-occurrence matrix texture analysis

In order to calculate GLCM parameters of DTSCs nuclei, an Image]
plugin called “Texture Analyzer” version 0.4 was applied (http://rsb.
info.nih.gov/ij/plugins/texture.html; developed by Julio E. Cabrera).
The analysis was performed on grayscale 8-bit images (Fig. 2B, 2F),
with the size of the step in pixels set to 1 and the direction of the step
set to 0°. The following five parameters were computed: angular second
moment (ASM), inverse difference moment (IDM), contrast (CON),
entropy (ENT) and correlation (COR) by following formulas:

ASM = ZZ{p(z’,j)}z @

IDM = ZZH( 5

Ney N, N,
CON =Y"n*33" > p(i.j).|i—j|=n 6)

>p(i, J) 5)

n=0 i=l j=1
ENT:—ZZp(i,j)log(p(i,j)) 7)
COR = Z il Sl p(.J) (®)

2 foon

The term p(ij) is the ith and jth entry in a normalized gray-
tone spatial-dependence matrix (i.e. the co-occurrence matrix) and
N, is the number of distinct gray levels in the quantized image. The
above mentioned formulas, originaly described by Haralick et al.
[25] are implemented in the “Texture Analyzer” Image ] plugin. The
only parameter computed differently is COR, which is calculated as
described by Walker et al. [26]. Texture analysis aims to indentify
texture features of object in an image by analyzing combinations of
intensities at specified positions that are relative to each other in the
image [27]. Statistical texture analysis can therefore be classified into
first-order, second-order and higher-order statistics according to the
number of intensity points (pixels) in each combination. The GLCM
texture analysis aims to describe the second order texture features [27].
Originaly Harlick et al., [25] described a total of 14 statistical texture
measures that are based on gray tone spatial dependencies. From
those 14 parameters, 5 parameters are commonly used in biomedical
research for image classification purposes [25]. ASM, also known as,
Energy and IDM, also known as Homogeneity, are measures of image
homogeneity. High ASM and IDM values are thus present when the
image is made of pixels with very similar gray level values, which points
to the texture that is uniform and contains repetitive structures [28].
CON and ENT are measures of image heterogeneity, and represent
measures of gray level variation and spatial disorder. High CON values
can be found in heavy textures images, while high ENT indicates that
the image texture is statistically more chaotic [28]. COR is a measure
of gray level linear dependence between the pixels at the specified
positions relative to each other [27].

Statistical analysis

Statistical analysis was performed using Student’s t test and Mann-
Whitney’s U test, where appropriate. Results are represented as mean +
standard error of mean, and as median with interquartile range. For p
values less than 0.05, the differences between the means of populations
were considered statistically significant.

Results

The fractal analysis of “binary-outlined” nucleus showed no
statistical significance between two groups. On the other hand, the
fractal analysis of “black-and-white” nucleus images showed significant
statistical differences between two groups of cells (Table 1).

GLCM texture analysis showed high statistical significance in all of
the five computed parameters (Table 2).

Table 1. The average fractal dimension of DTSCs “binary-outlined” and “black-and-white” nuclei obtained from SA-B-Gal  and SA-B-Gal" groups.

Parameters Group t P
SA-B-Gal SA-g-Gal*
D, 1.083 + 0.004 1.085 + 0.002 0.613 0.542
D 1.811 £ 0.007 1.781 + 0.005 3.595 <0.001

*Results are represented as mean =+ standard error of mean. Abbreviations: D — fractal dimension of the “binary-outlined” nucleus images; D,; — fractal dimension of “black-and-white”

nucleus images.

bin

Table 2. Parameters of GLCM texture analysis of nuclei obtained from SA-B-Gal and SA-B-Gal* groups of DTSCs.

Parameter SA-B-Gal
ASM 0.97772 (0.97457 — 0.98027)
IDM 0.99312 (0.99229 — 0.99413)
CON 25.2682 (25.2318 —25.3017)
ENT 0.13293 (0.11421 — 0.14494)
COR 0.00941 (0.00751 — 0.01128)

SA-B-Gal* U )
0.95598 (0.94166 — 0.96482) 72.000 <0.001
0.9869 (0.9829 — 0.9899) 77.500 <0.001
25.3591 (25.2931 — 25.4938) 640.000 <0.001
0.24854 (0.19733 — 0.31466) 69.000 <0.001
0.00614 (0.00432 —0.00901) 618.000 <0.001

*Results are represented as median with interquartile range. Abbreviations: ASM — angular second moment; IDM — inverse difference moment; CON — contrast; ENT — entropy; COR —

correlation.
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Discussion

Although standard quantitative methods in science are based on
classical Euclidean geometry, early research showed that the most
common biological patterns were characterized by fractal geometry
[29,30]. Up to now the concept of fractal geometry is being used in
diverse research areas and is proving to be an increasingly useful
tool. In fractal analysis, a type of quantitative analysis derived from
fractal geometry [31], there are two basic methods to measure the FD
of objects in a plane: the first and most commonly used is a length-
related method, while the second method is a mass-related method [29].
Although there are no strict guidelines for the application of fractal
analysis, the majority of researches tend to use box-counting method to
calculate the FD of digital images, making this method one of the most
frequently used [31].

In our study the box-counting method of fractal analysis applied
on nuclei of SA-B-Gal* and SA-B-Gal cells, i.e. senescent and non-
senescent cells, gave two different types of results. The first result
showed no statistical significance between the mean FD values of
the “binary-outlined” nucleus, while the second result showed high
statistical significance when fractal analysis was applied on “black-and-
white” corresponding images of the nuclei. These contradictory results
can be explained by the different parameters which were measured
by these two methods. The first method, measured the shape of the
nucleus, while the second method evaluated the space-filling property
of an image of the nucleus. It has been reported previously [30] that the
box-counting method applied on binary images of neurons depends on
the way the image is displayed. While the box dimension of “binary-
skeletonized” images summarizes the degree of dendrite aberrations
from straight lines [32], the same parameter for “binary-outline”
images defines the irregularity in the shape of the image. In addition,
the box dimension of the “black-and-white” images represents a robust
technique for estimating how the extent of the image deviates from
the extent of the geometric figure, according to resolution [33]. Thus,
according to our results, the fractal analysis of certain geometrical
shapes, such as the shape of cell nuclei, should be done on “black-and-
white” images, which in these conditions give more adequate results
than the analysis on the “binary-outline” images.

The biological differences obtained in the values of nucleus FD in
senescent and non-senescent cells on “black-and-white” images can
be explained by changes that occur in the process of stem cell aging
[4]. Namely, it was noticed that increase in whole cell size and nuclear
size is often associated with senescence [34,35]. Also, abnormal nuclear
morphology, such as irregular shape or fragmentation, is often seen in
senescent cells [36]. Thus, it is not surprising that “black-and-white”
nuclei images of SA-B-Gal* senescent cells have lower values of FD
than B-gal- cells, most likely due to the loss of their normal shape
and structure. This result is in accordance with other researches that
showed that with aging, FD of certain tissue decreases, thus pointing to
the loss of structural complexity as a consequence of tissue age-related
degradation and deterioration [18].

Besides fractal analysis, GLCM texture analysis has proven to be an
even better method in detecting the stem cell senescence in vitro. In our
research, all five computed GLCM parameters showed high statistical
significance between two groups of cells. As mentioned earlier, ASM
and IDM are two parameters that measure tissue homogeneity,
whereas second two parameters, CON and ENT measure tissue
heterogeneity [25]. Also, IDM relates inversely to CON, while ASM
is an opposite of ENT. COR measures the grey-linear dependency of
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neighboring pixels, where high COR indicates greater pixel similarity
and low COR points towards irregularity in image texture [37]. Our
results showed that nuclei of SA-B-Gal* cells, have higher values of
ENT and CON than SA-B-Gal cells, while ASM, IDM and COR of
cell nuclei are higher in the SA-B-Gal" group. These results can be
explained by the changes in the chromatin structure in senescent cells,
whose nuclei show significant structural changes. The most prominent
is formation of the senescence-associated heterochromatic foci [38].
Second is distorted organization of the nuclear lamina [5,39], such as
downregulation of lamin B1 [40], which leads to the permeabilization of
the nuclear envelope. It causes a loss of chromatin from the nucleus to
the cytoplasm, together with a progressive decrease in histone content
[41]. In this way, the normal nuclear architectonic is lost, leading to
an increase in pixel heterogeneity and decrease in pixel homogeneity,
which can be detected by GLCM parameters of texture analysis, as it
is shown by our results. These results are in accordance with Pantic et
al. [42] who have shown an increase in nuclear ENT of hematopoietic
erythroid cells with age.

To our knowledge, this is the first study to show the usefulness
of fractal and GLCM texture analysis in the detection of stem cell
senescence. Our study had certain limitations, due to which it can
be considered as a pilot study. The main limitation is the number
of biological specimens from which images of DTSCs nuclei were
extracted. Although, stem cells were obtained from only one tooth, this
is not uncommon in stem cell research, where different experimental
procedures are often done on stem cells isolated from one tooth or
patient [43-45]. Thus, the next research step could be the application of
these two methods on a larger number of specimens and on different
types of mesenchymal stem cells isolated from various tissues. Besides
B-galactosidase staining, additional markers of stem cell senescence
should be included in future studies to obtain the most accurate results
about the application of these two mathematical methods in senescence
quantification.

Conclusion

As shown in our research, fractal and GLCM texture analysis of
cell nuclei have proven to be a useful method to quantify stem cell
senescence. Besides theoretical, these results also have a practical value,
as they may become a new marker for laboratory detection of stem cell
senescence, since they are easy to apply and carry no financial cost.
The possible role of these methods in future studies can be directed
to discriminate stem cells from different passages, to study the effects
of different factors on the nuclear complexity of various cell lines or
as tool for detecting stem cell differentiation. Although still in the
early phase of application, several studies have recently used fractal
and GLCM texture analysis for the similar purpose [21,46]. If future
studies confirm the validity of these methods, a possible next step in the
process of application could be a development of automated software,
which would be able to calculate fractal and GLCM texture parameters
in real time, without previous image processing.
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